
This instruction sheet aims to help you set up a Map File for use in ArcGIS Field Maps for both students 

and researchers. ArcGIS Field Maps allows you to record data in the field and streamline data processing 

once you return to the lab. However, before collecting your data, you need to create a Map File in 

ArcGIS Pro that contains the template feature layers for each type of data you may wish to collect and 

the datasets (e.g., LiDAR DSM) that may aid your fieldwork.  

To begin with, we need to access the latest version of ArcGIS Pro, version 2.8.3. Go to apps.uib.no/login 

and sign in to AppsAnywhere using your UiB credentials. Once you have signed in, you will be 

prompted to Open AppsAnywhere Launcher; click ‘Open AppsAnywhere Launcher’ in the browser box. 

Once you have clicked the button, wait to be verified by the webpage (this can be seen at the top of the 

webpage). Following the successful validation message, search for ‘ArcGIS Pro’ in the search bar 

located in the top right of the screen. Next, hover over the app icon and click ‘Launch 2.8’. Again, you 

will be prompted to ‘Open AppsAnywhere Launcher’, click ‘Open AppsAnywhere Launcher’. The 

Cloudpaging Player window will appear on your screen. Wait for ArcGIS Pro to initialise and then click 

the ‘Launch’ ( ) button, and ArcGIS Pro will open. 

The first time you open the software, you will be asked to sign in. All students and staff at the University 

of Bergen can use their UiB login credentials to sign in to ArcGIS Online and ArcGIS Pro.   

1. After opening ArcGIS Pro for the first time, click on Your ArcGIS organisation URL. 

 

On the next page, enter uib, tick “remember this URL” below, and then click ‘Continue’. 

 

Then click ‘UiB (O365) Login’ and proceed to log in with your UiB account. ArcGIS Pro will 

now open up.  

https://apps.uib.no/login


2. Once logged in, click the Map ( ) button located beneath New – Blank Templates. Give your 

project a name and define the save location (you can use the default location unless there is a 

specific location on your drive you wish to save the project to). 

ArcGIS may be structured differently from the GIS packages you have used before. A summary of some 

of the tabs and panes is given in the figure below. 

 

Now that the project is set up, we will prepare it for use in ArcGIS Field Maps. 

1. As a first step, we may need to change the projection of our map to match the coordinate system 

most appropriate for our study region. By default, the map is set to ‘ETRS 1989 UTM Zone 

32N’, perfect for working in southern Norway. However, if you are working in Nordland or 

Troms og Finnmark, you will need to change it. 

In the Contents pane, right-click Map and then click Properties. In the Map Properties pop-up 

box, go to the Coordinate Systems tab. In the XY Coordinate Systems Available box, you will 
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see ‘ETRS 1989 UTM Zone 32N’ highlighted in blue; beneath, you will also see zones 33N-

36N, which cover the northern regions of Norway. Click the zone you need so that it is 

highlighted, and you will see the Current XY box located above has changed to your selected 

coordinate system. Click OK at the bottom of the pop-up box to confirm your selection and 

close the pop-up. 

If you are working further afield outside of Norway, you can find additional UTM Zones in the 

XY Coordinate Systems Available box under Projected Coordinate Systems → UTM → WGS 

1984 → Northern Hemisphere/Southern Hemisphere. If you are unsure of the UTM coordinate 

system you should be using for your study region, you can use this online interactive map to 

determine which projection to use. 

Once changed, all the feature layers you create and add to the map in the later steps of this 

instruction sheet will be georeferenced using your map’s coordinate system. Therefore, it is 

important that you are sure of the coordinate systems you will be using before you continue, as 

changing the coordinate system of feature layers and raster layers can be laborious and 

occasionally computationally intensive to perform. NB: You cannot publish layers with 

different coordinate systems to your map to ArcGIS Online. 

 

2. We need to choose an appropriate basemap layer that can provide useful auxiliary data that 

enhances our interpretational ability when working in the field. Go to the Insert tab on the 

ribbon. Click the Basemap ( ) drop-down button. Here you can see an array of basemap layers 

available for use.  

 

Scroll down to find the Bilder (UTM32) or Bilder (UTM33) basemap layers (choose according 

to your coordinate system). This basemap layer provides high-resolution satellite and ariel 

photography of Norway dated from 2019. The imagery is used based on image data used by 

Kartverket, Geovekst, and Norway’s municipality authorities. If working outside of Norway, 

the ‘Imagery’ basemap layer provides high-resolution (<1 m) imagery of the rest of the world. 

 

3. Now we will create and add the feature layers we will use to collect data in the field. In the 

Catalog pane on the right-hand side, under the Project tab, click the arrow next to ‘Databases’ 

to reveal the ‘Default.gdb’ database. This database will contain all the feature classes you create. 

To add feature classes to the database, right-click the database, click ‘New’, followed by 

‘Feature Class’. 

https://mangomap.com/robertyoung/maps/69585/what-utm-zone-am-i-in-%23


A new pane, Create Feature Class, will replace the Catalog pane. The pane features 6 tabs: (1) 

Define; (2) Fields; (3) Spatial Reference; (4) Tolerance; (5) Resolution; and (6) Storage 

Configuration. We only need to concern ourselves with the first 3. 

 

1. Define - Name your Feature Class according to the data you wish to collect. NB: 

Feature Class names cannot feature ‘space’ characters when saved to your database, 

use underscores ( _ ) instead.  Setting the ‘Alias’ is optional. Below you can set the 

‘Feature Class Type’, choosing between a multitude of options. Typically, you will 

choose to create either Polygon, Line, or Point feature classes according to the type 

of data you wish to collect: 

 

a. A polygon is a closed shapefile that defines an area within a connected 

sequence of coordinates. Useful for demarcating the area of a landform or 

any other entity that can be defined by an area. 

 

b. A line (or polyline) is a shapefile defined by one or a series of paths. Useful 

for plotting transects or waterways. 

 

c. A point is a shapefile containing a single set of X and Y coordinates. Useful 

for plotting areas of interest, sample collection location, or sediment coring 

locations. 

 

Leave the remainder of the options as their default once you have chosen the 

‘Feature Class Type’. Click ‘Next’ at the bottom of the pane. 

 

In this example, we are going to call our Feature Class 

‘Sediment_Sample_Location’ and set the ‘Feature Class Type’ to Point. The 

purpose of this Feature Class is to demarcate the positions of our sample collection 

locations.  

 

2. Fields – Fields are the columns of our Attribute Table. Each field can store a specific 

data type, such as text, dates, and numbers.  

 

In the Fields pane, click ‘Click here to add new field’ located beneath the existing 

table. 

 

 

 

 



You will give each Field a name in the Field Name column and a corresponding 

data type in the Data Type column. You can choose from a selection of data types:  

 

• Short integer, Long integer, Float, and Double concern number inputs, with 

the maximum amount of numbers you can input for the field increasing in 

size from Short integer to Double. Typically, Long integer is the most 

appropriate data type for storing numbers. 

 

• Date allows you to record dates and times.  

 

• Text allows you to input textual descriptions. The character limit is set to 

255 by default. 

 

• BLOB (Binary Large Object) allows you to store large binary code 

sequences. 

 

• ObjectID allows for unique ID numbers for each row in your attribute table. 

You can see that ObjectID has already been added by default by ArcGIS 

Pro. 

 

• Global ID and GUID store unique strings of characters that can be used to 

identify features within a geodatabase and across geodatabases. 

 

There are many fields you may want to consider adding. In the 

Sediment_Sample_Location example, we have included ‘Name of Area’, ‘Name of 

sample bag’, Date of Collection’, ‘Deposit type’, ‘Sample Depth’, ‘Description of 

Area’, and ‘Collector Name’. Of course, the names of the fields you add will vary 

dependent on the data you need to collect for the Feature Class. Once you have 

added all the fields you wish to add, click ‘Next’ at the bottom of the tab. 

NB: Attributes such as area and length are automatically added by ArcGIS when 

working with Polygon and Polyline feature classes, so there is no need to add them 

yourself. 

 

3. Spatial Reference – By default, the spatial reference for the Feature Class will be 

set to the XY Coordinate System you set earlier for your map; therefore, you do not 

need to change anything in this tab. However, if you wish to change the reference 



for whatever reason, you can do so here. From here, you can click ‘Finish’ at the 

bottom of the tab. Once the Feature Class is created, ArcGIS Pro will return you to 

the Catalog pane, and you will find your new Feature Class located in your 

Default.gdb database. 

The feature class will also appear in the Contents pane on the left-hand side of the 

screen. 

 

4. You can make changes to your new Feature Layer following creation if, for example, you need 

to add a Field column you forgot, change the data type of the Filed columns, or further adjust 

the type of data you can collect.  

 

Select the Feature Class in the Contents pane and open the Data tab on the ribbon. Within the 

Design group, click the Fields ( ) icon. A new Fields tab will open on the Open Maps Tab 

Bar.  

Here, you can make changes to your field columns. For the ‘Sediment_Sample_Location’ 

example, double-clicking ‘Numeric’ in the Number Format column allows us to adjust the 

number of decimal places or set the number type to ‘Percentage’ or ‘Angle’, among others. We 

can also adjust the number of characters we can enter into our text fields so that we may enter 

more detailed descriptions or the date format of our date fields in the Number Format column. 

Once you have made your changes, save them by clicking the Save ( ) icon in the Fields tab  

on the ribbon. Close the Fields tab by clicking the ‘x’ in the Open Maps Tab Bar.  



 

5. If you have created polyline and polygon feature classes, you are required to change the ‘Display 

Field’ from ‘Shape_Length’ for the feature class in order to publish the map to ArcGIS Online 

later. 

 

In the Contents pane, right-click the feature class and click Properties. In the Layer properties 

pop-up, go to the Display tab. In the Display Fields drop-down list, select an attribute feature 

other than ‘Shape_Length’ or ‘Shape_Area’. Once chosen, click ‘OK’ at the bottom of the pop-

up. 

 

6. Using the ‘ArcGIS Field Maps’ app, it is possible to add attachments (e.g., photos, videos, audio, 

and documents) to your polygon, polyline, and point feature classes. By default, feature classes 

are not set up to store attachments. To allow the feature class to store attachments, we will run 

the Enable Attachments tool.  

 

In the View tab on the ribbon, click the Geoprocessing ( ) icon. The Geoprocessing pane will 

now open on the right-hand side of the screen. In the search bar at the top of the Geoprocessing 

pane, search ‘Enable Attachments’ and open the Enable Attachments tool. 

Set the Input Dataset parameter to the dataset you wish to allow attachments to be added to. 

Then, click ‘Run’ ( ) at the bottom of the pane. Once the tool has finished running, you 

will be able to add attachments to the feature layer out in the field. NB: The Enable Attachments 

tool creates a geodatabase table and geodatabase relationship class, which you can view in your 

Default.gdb database. 

 

7. If you have pre-existing feature classes or auxiliary datasets you wish to use to aid your 

fieldwork and data collection, such as Digital Surface/Terrain Models (DSM, DTM), contour 

lines, or other imagery, you can add those to your map now.  

 

It is important to remember that high-resolution datasets have large file sizes. In order for you 

to use these files in the field where you may not have cellular service, you will need to download 

these files to the ArcGIS Field Maps app on your device. Ensure your device has enough storage 

to save your map with the dataset file included. Do not let this deter you from using high-

resolution datasets, as later in this instructions sheet, you will find out how to subset maps for 

offline use, which can significantly reduce the amount of storage you need to download your 

map. 

 

To add data in ArcGIS Pro, you can drag and drop the dataset file from the ‘Windows File 

Explore’ ( ) app into the Contents pane. Alternatively, under the Map tab on the ribbon, click 

the Add Data ( ) button located in the Layer group. The ‘Add Data’ pop-up window will 

open. Here, you can search your computer ( ) for the files you wish to add. You can also find 

files in the Portal ( ). Within the Portal, you have access to files published on ArcGIS online 

( ), ArcGIS Living Atlas ( ), and files previously published by other UiB users on ArcGIS 

online ( ).  



 

8. Once you have added all the layers to your map, you are ready to publish it to ArcGIS Online. 

Open the Share tab on the ribbon. Within the Share As group, click the Web Map ( ) button. 

The Share As Web Map pane will open on the right-hand side of the screen.  

 

Give your map a name that makes it easily identifiable. You are also required to provide a 

summary (description) of the map and tags before you can publish it. Choose appropriate tags 

based on the content of your map and its purpose. NB: Press the ‘Enter’ key on the keyboard to 

add the tag. 

 

From the ‘Select a Configuration’ drop-down, select the ‘Editable’ configuration. The ‘Editable’ 

configuration is the only configuration that allows you to collect data and edit feature classes 

(add attributes) in the field. 

 

It is not necessary to select a location folder. 

 

You can set the sharing option for your map. Leaving the checkboxes empty publishes the map 

to your ArcGIS Online account and is only visible to you. Checking the ‘Universitetet i Bergen’ 

check box shares the map with all users with accounts on the UiB ArcGIS server. Checking the 

‘Everyone’ text shares the map with the public – you may wish to choose this option if you are 

publishing the map for use at multiple institutions. Additionally, if you are part of a group within 

UiB’s ArcGIS Online server, you will have the option to share the map within your group too. 

 

NB: You can change the sharing options for your map once it has been uploaded to ArcGIS 

Online. 

 

9. Once you’ve set the item details, configuration, and sharing parameters, open the Configuration 

tab at the top of the Share As Web Map pane. 



 

In the main box of the Configuration tab, select the item with the ‘_WFL1’ extension, and then 

click the Properties button. The Configure _WFL1 web layer pane will open. 

Items with the _WFL extension are ‘Web Feature Layers’. In this case, the layers within the 

_WFL group will be the feature classes you created earlier.  

 

Items with the _WTL extension are ‘Web Tile Layers’. Layers within the _WTL group are 

layers that come in the form of tiles, such as raster layers. These layers are always non-editable 

within ArcGIS Field Maps. 

 

NB: Your Web Tile Layers are converted to .jpg and .png formats following their upload to the 

ArcGIS servers. This means Web Tile Layers cannot be used to perform geoprocessing tasks in 

ArcGIS Pro following fieldwork. Ensure you keep the original raster (.tif) files if you wish to 

use them later for geoprocessing. 

 

Under the General tab, you can change the name of the Web Feature Layer, its summary and 

tags, as well as setting any folder you may wish to save the Web Feature Layer located in your 

ArcGIS Online profile. 

 

Once you have finished in the General tab, open the Configuration tab at the top of the pane. 

Beneath the ‘Operations’ drop-down, you can select the accessibility and editing permissions 

of the Feature Layers on your map.  

 

a. Ticking the ‘Approve for Public Data Collection’ box is only necessary if you are 

sharing the map with institutions and groups outside of UiB. 

 

b. Beneath the greyed out ‘Enable editing and allow editors to:’ section, you can select the 

editing permissions of the layer. The permissions for each option are as follows: 

 

i. Add, update, and delete features: Users can add, update, and delete feature 

geometry and alter existing attributes or features. This is generally 

recommended for all scenarios. 

  

ii. Update feature attributes only: Users can only update attributes for existing 

features. They cannot create, modify, or delete existing feature geometry. 

 

iii. Add feature only: Users can add new features and enter new attributes for these 

new features. They cannot modify or delete existing feature class geometries or 



attributes. You may wish to select this option if working in large groups (e.g., 

field classes) to prevent the accidental deletion of features.  

 

c. Ticking the ‘Enable Sync’ allows you to work with a local (downloaded) copy of the 

Web Feature Layer. It is highly recommended you check this box, as it allows you to 

add, update, and delete features offline - i.e. if you lose cellular connection out in the 

field or are going to an area with no cellular service at all. Once you reconnect to the 

server, the changes you made offline will synchronise with the online map. 

 

d. Export data allows other users to export the data to other formats. 

 

Under the properties drop-down, ensure you have ‘Apply default to features with Z-values 

(leave the default z-value as 0) and ‘Allow geometry updates without m-value’ ticked. You can 

optionally select ‘Preserve editor tracking info’; this allows you to track which users edited 

features and attribute fields. With this selected, you may encounter issues editing pre-existing 

feature classes created on a desktop rather than on ArcGIS Field Maps.  

 

Once you have finished in the Configuration tab, click the ‘Analyze’ ( ) button at the 

bottom of the pane. The Messages tab will open in the pane. Analysing the Web Feature Layer 

will check for potential performance errors or bottlenecks. Errors with a ‘ ’ symbol must be 

addressed before publishing to ArcGIS Online, whereas errors with a ‘ ’ are recommended 

fixes but do not have to be addressed before publishing. 

 

To address the errors, right-click the error in the Message tab box, and then click ‘Help’. You 

will be directed to an ArcGIS help webpage that will provide instructions on fixing the errors.  

Once you have run the analysis and addressed any errors, you have finished configuring your 

Web Feature Layer. Return to the Map pane by clicking the back arrow ( ) at the top of the 

pane. 

 

10. We will now configure our Web Tile Layers (_WTL). In the Share As Web Map pane, open the 

Configuration tab. Select the item with the ‘_WTL1’ extension, and then click the Properties 

button. The Configure _WTL1 web layer pane will open. 



Under the General tab, you can change the item details and set the ArcGIS Online save folder. 

 

Once you are finished in the General tab, open the Configuration tab from the top of the pane.  

 

1. Dependent on the type of datasets you have in the Web Tile Layer group, you will 

see different options for choosing a ‘Tiling Scheme’. In most cases, you won’t be 

able to select the Tiling Scheme; instead, you will be set at the default ‘Same as 

basemap’, which is perfectly fine for ArcGIS Field Maps. 

 

2. The Tiling Scheme determines the level of detail your Web Tile Layers provide, 

their format, and compression. Under ‘Levels of Detail’, you can adjust the sliders 

to set the map scales at which the Web Tile Layers will be generated. You can use 

the scale box located in the bottom left of the Open Map tab to determine the 

minimum scale you will view the Web Tile Layers from – this can be in reference 

to the size of the study area, for example. It is recommended that you set the 

maximum scale to the highest possible to view the layers at smaller scales. 

 

3. Set the ‘Image Format’ to ‘Mixed’ and set the ‘Compression’ to 75. You may wish 

to increase the compression to preserve finer details at smaller scales; however, this 

comes at the cost of large file sizes. Ensure your mobile device or tablet has enough 

storage space to download the map if you increase the compression.  

 

4. Under the ‘Options’ drop-down, you can choose how to build the cache. If the cache 

size is small, set the cache to build automatically on the server. If the cache is large, 

set the cache to build manually on the server.  

 

5. You can estimate the size of the cache by clicking ‘Calculate’ ( ) under the 

‘Estimate’ tab. Clicking ‘Calculate’ opens the ‘Estimate Cache Size’ pop-up 

window. In the drop-down box, you can choose ‘Good’ or ‘Best’ for the estimation 

quality. It is recommended that you choose ‘Best’ to know how large your cache 

size will be. Click ‘Run’ ( ). 

 

If your estimated cache size is greater than 70 MB, it is recommended that you 

choose the ‘Cache manually on server’ option. 

 

Finally, check the ‘Allow clients to export cache tile’ box. This allows you to 

download the tiles for offline use. You can set the maximum number of tiles a user 

can download in a single request. You can see the number of estimate tiles in the 

‘Estimate Cache Size’ results. 

 



6. Once you have finished in the Configuration tab, click the ‘Analyse’ ( ) 

button at the bottom of the pane, address any potential errors, and return to the Map 

pane by clicking the back arrow ( ) at the top of the pane. 

 

11. If you have existing Feature Class layers you do not wish to allow editing for, you can separate 

it from _WFL1 by selecting the layer in the Configuration tab and then clicking the ‘Split’                      

( ) button. This will create a new Web Feature Layer with the extension _WFL2. You can 

change the editing permission of the new Web Feature Layer by following instruction 9. You 

can return the new Web Feature Layer to the original by holding the Crtl key, selecting the two 

_WFL layers, and clicking the ‘Combine’ ( ) button. 

 

12.  Once all Web Map Layers are configured, return to the Map pane. In the Map tab, click the 

‘Analyze’ ( ) button to check for potential errors one final time. If no errors are found, 

you are ready to publish the map on ArcGIS Online by clicking the ‘Share’ ( ) button. 

 

13. Once the map has been published, you can find the map and the Web Map Layers on ArcGIS 

Online. Go to https://www.arcgis.com/index.html and sign in using instruction 1. Once you have 

signed in, click the Content tab on the ribbon at the top of the screen. On the My Content page, 

you will see your published map and Web Feature Layers.  

 

https://www.arcgis.com/index.html


14. We still need to edit some permission on ArcGIS Online in order to use the map out in the field.  

 

Click the Web Map you created; this will take you to the map’s overview page. Here you can 

add further descriptions, see the layers that belong to the map, and have a plethora of viewing 

options. 

 

Open the Settings tab in the top right of the screen. Here you can ensure your map is available 

to be taken offline by toggling the ‘Enable offline mode’ toggle on.  

You should also create a Map Area to allow your map to be downloaded faster and become less 

computationally expensive to operate within the ArcGIS Field Maps app. Click the ‘Manage 

Areas’ button to open the ‘Manage Areas Map’. Here, you can use the rectangle or polygon 

builder to define the Map Area. 

 

Once you have defined the area, define the level of detail of the downloaded layers using the 

sliders. Click ‘Save’ once you have finished, and ArcGIS Online will package your Map Area. 

Once the Map Area has been packaged, you can close the Manage Areas Map by clicking the 



‘x’ in the top right of the screen. NB: Packaging can take a while; it depends on the size of the 

datasets being packaged.  

 

15. Return to the My Content page and open the Web Tile Layer (_WTL) overview by clicking on 

the ‘Tile Layer (hosted)’ file. Open the Settings tab. Scroll down to the ‘Tile Layer’ group. If 

you selected to build your tiles manually, click the ‘Build Tiles’ button. The ‘Build Tiles Pop-

up’ will appear on the screen. Check the boxes for each scale you wish to build tiles for, and 

click ‘Create Tiles’. The Pop-up will then state how many tiles you will be building and the 

storage required for the tiles. Click ‘Yes, create tiles’ to begin the tile building process. Once 

finished, return to the My Content page. 

 

16. If your map is to be shared with other institutions for data collection, you will need to ensure 

the Web Feature Layer map is set for public data collection. From the My Content tab, open the 

Web Feature Layer (_WFL) overview by clicking the ‘Feature Layer (hosted)’ file. Next, open 

the Settings tab in the top right of the webpage. In the ‘General’ group, under ‘Public Data 

Collection’, ensure that the ‘Approve this layer to be shared with the public when editing is 

enabled’ tick box is checked. Click ‘Save’ at the bottom of the group. 

 

Scroll down to the ‘Feature Layer (hosted)’ group. Ensure that the layer is enabled for editing 

and sync. You can adjust the permissions you set in ArcGIS Pro here if you wish to. Ensure you 

click ‘Save’ at the bottom of the group if you made changes. Return to the My Content page. 

 

Now your map is ready to be downloaded onto your device and be used in the field! 

Before you use your map in the field, you can improve the efficiency of your data collection by setting 

up Smart Forms. Smart Forms allow you to adjust the position of the fields you created for your Feature 

Classes, suggest what data should be collected for the field, select which fields are available for data 

input following the input of prior data, and add entirely new fields. 

1. On ArcGIS Online, click the App Selector ( ) button located in the top left of the screen next 

to your username, and then click Field Maps ( ). The Field Maps tab will open in your 

browser. 

 

2. Within the Field Maps browser tab, underneath the Maps tab, click on your Web Map. The 

Map Overview will open.  



3. In the pane on the left-hand side of the screen, click the Content tab. 

 

4. In the Content pane, you will see all the Feature Layers attached to your Web Map. Click on the 

Feature Layer you wish to create a Smart form for. The Form tab and Form Builder pane will 

open.  

 

5. In the Form Builder pane, beneath the Fields drop-down, you can see the fields you created 

your feature class in ArcGIS. Beneath the Form Elements drop-down, under BASIC, you will 

see the different field types. You can use these field types to add new fields to your Feature 

Class if, for example, you forgot to add a field before publishing. 

 

6. To add a new field, click and drag the BASIC field type into the Configure Form box beneath 

the Form tab. 

 

7. Once added, the Properties pane will open on the right-hand side of the screen. Once you set 

the name of the new field, you can adjust the Input Type, decide whether the field is required to 

be filled out, or decide if the field can be edited at all. You can also give the field a description 

to help students understand what data is expected to be collected for the field. The placeholder 

can display an example of the expected data format in the field box. 



8. Once you’ve added the new field, click the Save button located at the top of the Form tab ( ). 

Then, close the Properties pane by clicking the close ( ) button in the top right of the pane. 

 

9. Beneath the Fields drop-down are the fields you created in ArcGIS Pro. These fields can be 

added to the Smart Form by dragging and dropping the fields into the Configure Form box.  

 

10. Once the Smart Form is complete, click the Save button at the top of the Form tab ( ). Then, 

repeat the process for each of your Feature Classes. Your Smart Forms are now ready for use in 

the field. You can learn more about Smart Forms in this YouTube video: a small walkthrough 

showing you the Smart Form creation process begins at the 17:35 time stamp. 

 

 

 

https://www.youtube.com/watch?v=_M29_CGLQ_k

